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Learning outcomes for today

» Reminder of some of the basics of Mogul

* How to get more insights into your crystal structures
and interrogate results obtained from Mogul

* Interpreting not unusual / unusual results given context
* Analysis and impact of specific groups

» Explicative case studies
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CSD-Core - Conformations

Mogul provides precise information on
preferred molecular geometries

« Validate molecular geometries rapidly
using interactive plots & statistics

* |[dentify any unusual features of a given
query structure

« Mine millions of chemically classified
obond lengths, angles, torsion angles and
ring conformations in the CSD

®
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Mogul A @

* Incorporates pre-computed libraries of bond lengths, valence éngJes, :
torsion angles and ring conformations derived entirely from the«CSD

- Validate complete geometry: retrieve distributions, and figures of merit
for all bonds, angles, torsions and rings in the molecule

» Fragment Generalisation: If fragment specified is rare, Mogul will include
CSD results from the most similar fragments

« Hyperlinking to the CSD: View CSD entries in specific areas of histogram

* Integration with other software: Instruction file permits other programs
to interact with Mogul

Bruno et al, J. Chem. Inf. Comput. Sci., 44, 2133-2144, 2004 C C | >C



When could we use Mogul? Lm0

* In teaching to help us understand fundamental chemistry:-

* To help design and assess new materials such as drug molecules.
* To validate conformations
- To analyse calculated conformations

« To filter out protein-ligand docking solutions with unlikely ligand conformations
* To validate geometries

« To check molecular dimensions of new crystal structures

» To create restraint data/ligand dictionaries
* For protein refinement

« To guide small molecule structure solution from powder diffraction data

CCDC



Using Mogul to inform key decisions % S

* The term “solid form informatics” was first

i ﬂ t rO d U C e d | ﬂ m | d - 2 O O O S The integration of solid-form informatics into

solid-form selection
Neil Feeder?, Elna Pidcock?, Anthony M. Reilly’, Ghazala Sadiq®, Cheryl L. Doherty®, Kevin R. Back®,

« Use of structural knowledge to inform key decisions i S
INn pharmaceutical development

Keywords Abstract
Cambridge Structural Database;
qualty-by-design: salid-form nformatics; Objectives To demonstrate how the use of structural informatics during drug

solid-form selection development assists with the assessment of the risk of polymorphism and the

* Now a key part of the solid form development e e

Pfizer Global R&D, Sandwich CT13 9N, )mn:ifds ‘uf lhuus.ands nffltysmlfll:unt\fes ‘cnnlame.d m} the Cambridge Struc-

workflow at most major pharmaceutical CrystEngComm e

* ow the compari-

View Article Online

companies —

Knowledge-based approaches to co-crystal designf

Peter A. Wood,* Neil Feeder, Matthew Furlow, Peter T. A. Galek, Colin R. Groom

Cite this: CrystEngComm, 2014, 16. <
5839 and Elna Pidcock

Received 12th February 2014, The use of knowledge-based methods has been intimately connected with the field of co-crystal design

Accepted 10th March 2014 since the seminal papers of Etter and Desiraju in the 1990s. Here we explain and exemplify how rational
co-crystal design has been carried out in the past using crystal structure knowledge as well as presenting
emerging methodologies for knowledge-based co-former selection.

DOI: 10.1039/c4ce00316k
www.rsc.org/crystengcomm
1. Introduction the structure of a synthetic f-C-anylglucoside published by

Deshpande and co-workers in 20127 This crystal structure
The definition of a co-crystal,"* whether this is the correct  contains water, ethanol, a zwitterionic component and a

Molecule

Particle

term to use® and even whether it should contain a hyphen
has been debated at length in the literature. At the most
basic level, a co-crystal is a crystalline form composed from
two or more components with a particular stoichiometry.
Generally, the definitions used in the Crystal Engineering
field also place some or all of the following requirements on
the solid forms in question:

1. All components are organic species (ruling out inorganics
or organometallics).

2. None of the components are charged (otherwise classified
as salts).

3. None of the components are water (otherwise classified
as hydrates).

Robert Docherty et al Journal of Pharmacy and Pharmacology, (2015) 67, 857. doi: 10.1111/jphp.12394.
Taylor et al. J. Chem. Inf. Model., (2014) 54 (9), 2500. Wood, P. A. et al. CrystEngComm (2013) 15, 65

neutral AP1, so could be described as a co-crystal, hydrate,
solvate, zwitterionic salt or all of the above. Practically, the
definitions used will also vary based on the application of the
resulting co-crystal and the approaches for co-crystal design.
In this paper we focus mostly on systems where all the com-
ponents are neutral, organic species and point out if any
further assumptions or requirements are added through the
use of a certain design method.

Co-crystals are of interest in both academic research and
industrial application as they represent the opportunity to access
new solid forms and therefore modified physical properties.
This contrasts with polymorphism which, when observed, can
be difficult to control and rarely represents an opportunity to
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We can mine the CSD to identify
these intra and intermolecular
geometric preferences.
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Using Mogul to check new structural data” @

Distributions a ‘
@ AABHTZ (P-1) - Mercury — [m] e
Fie Edit Selection Display Calculate CSD-Community CSD-COFE SD-Materials CSD-Discovery  CSD Python APl Help Validation
External reference files . i
PickngMode: pickaoms | Cearveas @ Launch WebCSD ms ~ with atom Label v ! XM
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Launch lse5tar AACMAL  P21/c
IsoStar Settings... AACMHX... Pbca

Select Databases... I \ A\

Metric Score

Riroemm —=(1266 PDF report for depositor and
’ m a RSR-Z e - 0.123
®

-
N Backbone 0,056 referees:
‘ - “l""'z’ statistics and plots for the

Clostrcors s : .
' | l ( | l eS Underpacking = =13 entry, per chain, per residue,

RNE picactam o and list of unusual features

Worse Better

Display Options

@ Mogul Results Viewer —

showfhide: [Colmns ~| [Fragments...| | |Desclectalfiogmens | | Export.. B ccochons

File Searches Databases Hel

| Double dlick to view resuit in Hogul Blgey | Faninedws | Vo dnctes

1. Methods 2, Test methods

s oge search - Torson ange - C21 €22 C24 127 development. blind with
Type Molecule Fragment Classification No. of hits Query value A 137 w e unpublished
> bond Sactn: Ary. Hesst Senent: Ay
Exchde: tone targets.
> angle Relesance  Mumber  Contibuion
~ torsion 2 [T B
v LIM_K21.901-B_pdblhak_1 |
50058 C1C2 Not unusual {enough hits) 13451 169,071 N Crystal Structure
€59 058 C1 C6 Not unusual (enough hits) 13461 -10.086 : Prediction (CSP)
023 C21 NT1 C12 Mot unusual (enough hits) 45 11.263 H . H
€24C22 C21NTT Not unusual (enough hits) 40 75917 § n Blind Test.
€22 C24N27 C30 Mot unusual (enough hits) 938 -155.722 e O r e I ( a
€22 C24N27 C34 Not unusual (enough hits) 938 76119 e W .
€45 C52 C43 C32 Mot unusual (enough hits) 2357 -T.842
€51C52 Ca3 €32 Mot unusual (enough hits) 2357 105.277
€22 C21N11 €12 Mot unusual (few hits) 3 -165.684 o .
023 C21 N11C10 Unusual (enough hits) 43 -158.238 s ¢ “ [ -
023 C21C22 €4 Unusual (enough hits) 42 Vfrin) |: 274047 -
C21Caa CaaNa7 Unusual (enough hits) 137 RIS (BB S kg (et e 3. Compare predictions to
€31C32C43C52 Unusual (enough hit 131 Data races .
£33C32C43 €52 Unusual (enough hits) 131 e o skt oinsnnmngen | Gcoss - experimental observations.
€22 C21N11C10 Unusual (few hits) 3 At agmerts. e query. perlaredtis: e o5 update o o
= Selectedhits: 177 TR o8 s skogeam [ cso Peoi update | 0

inbar to deselect, cick agai

| J.Bruno, G.P.Shields, R.Taylor,A’CtO Cryst. (20wﬂ). B67, 333-349 DOI: 10.1107/S0108768111024608 ( < | N



Mogul - the basics Y,

« Covered in:

* July CCDC Virtual workshop series
* Now available on demand in CSDU

Analysing molecular geometriez 101 - basics of
Mogul

Explore how to use Mogul to assess the geometry of a
molecule using the information in over 1.1 million
gtructures in the CSD.

In this session you will leam how fo run a geometry
check in Mercury, how fo launch Mogul from Mercury
and how to interpret the results cbiained.

ol




Mogul - Launch from Mercury

Style: |Polyhedral

| animate...

Display Options

File Edit Selection

@ AABHTZ (P-1) - Mercury

Picking Mode: | Pick Atoms

~ Colour: by Element

Default view: b

o

a

~ | Clear Meag '.'

Display Calculate  CSD-Communit —20-COr€ sp-Materials  CSD-Discovery  CSD Python API

Launch WebC5D ms
ConCuest Hit Highlighting...
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Mogul Geometry Check...
Launch Mogul
Mogul Settings...
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Launch lsoStar
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AACRHA Pncm
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AADMPY10 P-1
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Mogul Geometry Check

C50-Core  C5D-Materials  CSD-Disce
@ Launch WebCSD
ConCuest Hit Highlighting...
‘ Launch ConCuest
Data Analysis Medule...

Mogul Geometry Check...
‘ Launch Mogul
Meogul Settings...

IsaStar Interaction Check..,
’ Launch |so5tar
IsoStar Settings...

Select Databases...

(v7] Mogul Search Settings —

Fragment Types

Bond Length Valence Angle Torsion Angle Ring

Search Filter Options
Available filters
R-factor <= 5.0%
Bxdude |Solvents

Heaviest Element U

% Apply filters
% Exdude |Organometallics
% Exclude

Search Mode
O Only find fragments that match exactly

Customise fragment classification ...

Help Search

\

“

%

Powder structures

@ Find similar fragments if number of exact matches is less than

Bonds Angles Torsions Rings

Close

s

A complete analysis of all loaded molecule(s) will be performed.

To analyse just part of the displayed molecule(s), hit 'Cancel’
and select atoms before starting the analysis.

@ search Progress

X

Angle I 54%
C8 C9 C14

Search completed - 41 observations «

CCDC



Mogul Geometry Check - Results Ty

7] Mogul Results Viewer — O *
Show [ hide : I Columns vI |Fragmer1ts... | [ |Dese|ect all Fragments| I
I Double click to view result in Mogul

Type Maolecule Fragment Classificatior? Ma. of hits Cuery value Mez ™

* bond

» angle

¥ torsion

hd LIM_K21_901-B_pdbThak_1
C59058C1C2 Mot unusual (encugh hits) 13461 169.071
C39038C1Ch Mot unusual (encugh hits) 13461 -10.086
023 C21 N1 12 Mot unusual (enough hits) 45 11.263
C24 C22C21 MM Mot unusual (encugh hits) 40 -75.917
C22 C24 N27 C30 Mot unusual (encugh hits) 938 -155.722
C22 C24 N2T C34 Mot unusual (enough hits) 938 76.113
C45C52C43 C32 Mot unusual (encugh hits) 2357 -71.842
C51C52 C43C32 Mot unusual (encugh hits) 2357 105.277
C22 C21 N1 212 Mot unusual (few hits) 3 -165.684
023 C21 N11 €10 Unusual (enough hits] 45 158.238
023 C21 C22C24 Unusual (enough hits) 42 107.065
C21C22 C24 N27 Unusual (enough hits) 137 -22.055
31 C32C43C52 Unusual (enough hits) 131 -140.16
£33 C32C43C52 Unusual (enough hits] 131 G7.369
C22C21MN11CI0 Unusual (few hits] 3 24.815 v
>

Double click

on a row to
view result in
Mogul

Colour code:

Blue: It is a not unusual value in
the CSD and there are enough
data in the CSD for comparison.

Pink: It is a not unusual value in
the CSD, but there are only few
data in the CSD for comparison.

Orange: It is an unusual value
iNn the CSD and there are
enough data in the CSD for
comparison.

Brown: [t is an unusual value in
the CSD, but there are only few
data in the CSD for comparison.



Mogul Geometry Check - Results

O CCDC Mogul 2020.3.0: AABHTZ (P-1) - Mercury

> vlo 4

Results and
filters

File Searches Databases Help
Build query Results and analysis View structures
Results Navigator
All hits: 449
Accepted hits: 449
R-factor: Any Heaviest Element: Any
Exdude: None
Relevance MNumber  Contribution

View diagrams. .. Mare hits...

Statistics

Total : 443
Selected : 449
Mean : 119.883%
Standard deviation : 1.790°
Minimum : 111,452
Lower gquartile : 113.909°
Median : 119,752°
Upper gquartile : 120,645
Maximum : 135.611%
| z-score | : 0,867

Statistic's

All fragments...

View query...

Mumber of hits

110

66 -

Histogram displa
0g play .
Displayed hits: 445
] Deselect
Selected hits: 445

Mogul search - Bond angle - C6 C5 CI2

Colour

Click to (de)select bars; dick and drag to {de)select a range

Histogram: click in bar to deselect, click again to reselect. Right-click for eptions.

all hits in histogram

all hits in histogram

Value i query: 121.434°

6

Value

Click bars or bihs to

deselect hits

Click and drag to
deselect a range

................................................. ‘ ........... inyour ..........................

e
0
0

Data libraries
C5D 5.42
CsD Feb21 update
CSD May21 update

Eilters...

vl

uster

. ©
» b
L J
o
» . . D
»
" 4
T
°
® @
o >
& s
A L
°

Histogram
built with
data from
structures in
the CSD

Cluster only
available for

< rings
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Mogul Geometry Check - View structurés . @

0 CCDC Mogul 2020.3.0: AABHTZ (P-1) - Mercury

File Searches Databases
Results and analysis View structures

Build query

Help

Refcode: AABHTZ Data Library: C5D 5.42

AABHTZ

.

—
Y

Fragment
@51\ shown

//

Valence angle:
119.477°

Measurement

given

C||Ck through hits

Show Parame ters

AABHTZ
ABAWI
ABAWOP
ABYTZL
ACBTZC
ACBTZDN0
ADAPIF
ADENON
AFESEK
AJETAL
AJETALDT
AMACGAH
AMACEL
AMACIP
APIKUH
AWIIA
AWIDG
AWDUM
AXEHIU
AXUTES
AYEZOV
AZITUA
BAKYAP
CAGNUU
CAGPAC
CEBLOM
CEQZI
ClGAD
CLPTBU
COPZOX
DAICAV
DAINUZ
nInMLA

W

196 structures k

Click through
the refcode list

Number of
structures

D



Using Mogul to check a new structure .

1. Load your structure in Mercury VAR TS 5 v7 S
* File > Open —to open one of your own files for example a CIF e :
! . ’ .
2. Don't forget to assign bond types VA e
« Edit > Auto Edit Structure to assign bond types Q ST
) ) C5D-Core | C5D-Materials  C5D-Disce
« Or File > Auto Edit Structure on Load to automate '@ Lounch WebCsD
3. Runthe Mogul Geometry Check..... | ComQuest Hit Highlighting..
Guess bond types @ Launch ConQuest
Q O an ]

File  Edit Selection Display Calculate Edit Selection Display Calculate CSD-C 1 Onvbondo it ke s S
Open... Ctrl+O Undo: Packing off Ctrl+Z LSl L
Recent Files " REdO: NOt Available CtrI+Y Standardise to Cambridge Structural Database I.I Launch MDQU|

conventions MGQUI SEtti”E!s---
Sketch Molecule... Ctrl+K Copy Image to Clipboard Ctrl+C Aromatic bonds
Delocalised Bonds lsoStar Interaction Check...

Auto Edit Structure on Load Launch lenStar

Auto Edit Structure... S
Save As.. Ctrl+S Normalise Hydrogens... I
POV-Ray Image... Polymer Expansion... Add missing H stoms Select Databases...
Printin 3D...

Transform Molecules...

Exit Ctrl+Q Change Spacegroup Setting... ose < < | > ‘




Intermediate Mogul )

O Mogul Search Settings - bt

. Fragment Types
° I:OC U S O m CO n -[:O r m a t I O m [ ] Bond Length [ ] Valence Angle Torsion Angle [ ] Ring ¥

Search Filter Options

« Torsion angles

Available filters
[ ] Rfactor <= 5.0%

[ ] Exclude  Solvents : y

[] Heaviest Element 1)
Apply filters

® Loca | d e nsrty Exclude | Organometallics e

Exclude Powder structures

« Percentage of experimental measurements
that are within x degrees of the value in the

ry mol |
que y O ecu e () Only find fragments that match exactly

« Torsion angle classified as unusual if local @ Find similar fragments if number of exact matches is less than
density < 0.05 (i.e. less than 5 % of bonds |15 | ngles (15| Tovsons a0 [ mings [
experimental values are within 10° of the
value in query molecule)

Search Mode

Customise fragment classification ...

Help Search Close

CCDC
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Example #1 (COBFIK) '
« COBFIK, a bipyridine derivative (5,5'—dichIoro—2,2'—bipy{idir)é), Ap'

»

. . .
* ] rotatable bond, with all 4 torsion angles returned as unusual - . -4, \
- g 1
>
@ Mogul Results Viewer - Ol Ko e o .
o
Show / hide : | Columns v| | Fragments... | [ ‘Deselectallfragments‘ [
<
I Double click to view result in Mogul
Type Molecule Fragment Classiﬁcat/i\on Mo, of hits  Query value Mean 5td. dev. |z-score| |x-mean| Minimum Maximum Median | d{min)| Local density ¢ o
v torsion
v COBFIK
N1 C1C6 N2 Unusual (enough hits) 2192 0.148 0.000 0.024
C2 C1 C6 N2 Unusual (enough hits) 4023 179.113 0.000 0.025
C7 C6C1 N1 Unusual (enough hits) 4023 -179.327 0.000 0.025
C2 C1C6C7 Unusual (enough hits) 2226 -0.362 0.000 0.023

~N

o

Mogul settings: No organometallics, no powder structures C C D C




Example :

Bimodal
distribution

Torsion angles
define relative
orientation of the
two nitrogen atoms

Major population
towards 180° and
mMinority population
towards O°

Observed torsion
angle value in
mMinor population
(125/2192 hits)

1 (COBFIK) "

@

Flle  Searches Databases Relp

Results Navigator

All hits: 2192

Accepted hits: 2192

R-factor: Any Heaviest Element: Any
Exclude: Organometallics, Powder structures

Relevance MNumber Contribution
> [«] 1.00 2192 100.0%

‘\.r'iewdiagrams...‘ ‘ Maore hits...

Build query Results and analysis View structures

@ CCDC Mogul 2021.2.0: COBFIK (P1) - Mercury - O

Statistics

Total : 2192
Selected : 2192
| d(min} | : 0.000°

All fragments... ‘ ‘ View guery...

Mogul search - Torsion angle - N1 C1 C& N2

1010 Ty e in query: 0.148°

&06 | .....................................................
n ; :
=
Y
o
h : :
0 B : B
2 o4ng | e e
2 H N H
202 | .................................................................. ..............................................
Minor
g : :
0 45 Q0
Torsion angle [ ©
Click to (de)select bars; click and drag to (de)select a range
Data libraries
Histogram display

Select | all hits in histogram CsD 5.42 lil
CSD Feb21 update ‘ Filters...

| CSD May2l update | I
all hits in histogram yeiup

Selected hits: 2192 CSD Sep21 update | 1 |

Displayed hits: 2192

Histogram: click in bar to deselect, click again to reselect. Right-click for options.

gos | .....................................................

Cluster




E le #1 (COBFIK N
xample #
S
. Build que Results and analysis View structures
+ Exploring the " N R -
l l . Information Refcode: AMILEN Data Library: CSD 5.42 AMILEN
structures in T2 -
) . Diagram ACILEG
mMajor population m— ADOBUQ
Isualiser ADOCA}(
. AFAJEZ
« QOver 2000 hits AFAZAI
AGINOW
(2067, 94.3 % of AHUSAA
. . . AJERIT
d|5tr|but|on) AJEROZ
AKIKOU
AKIROE
« All structures have AMEXOF
. . . . AMEXUL
bipyridine nitrogens AMIKUD
AMILEN
closer to trans to one iﬂltﬁ?“
another (facing in AMILIRO1
AMUHEW
] 1 i AMUHOG
opposite directions, | AL
o | APEGIN
180 ) APEPUH v

<< =

Reset display Display fragments

1215 structures

View entries



Example :

Exploring the
structures in
mMinor population

Only 125 hits (5.7 %)

Bipyridine
nitrogens closer
to cisto one
another (facing in
same direction, 0°)

Many (~70 %)
constrained as
part of a large ring
(macrocycle),
which may explain
cis adoption

=

1

Build query Results and analysis View structures

Information

Diagram

3D Visualiser

| View entries

Refcode: APEFIV Data Library: CSD 5.42

Reset display Display fragments

Murmber of hits

10107

606

Value in query: 0.148°

AFEFIV

ABIZUG ~
APEPIV
APEPOB
ARAPEQ
AZAFAK
BADQOP
CIYLUT
CIYMAA
COBFIK
DELCEC
DIBPUZ
DOZDAZ
EQUAQ
EQUEU
EQuUIY
EZACED
EZACIS
FIXQUB
FIXRAI
FIXREM
FIXRIQ
FOHMIA
FOLFOE
FOZDIH v

<< ==

84 structures
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Example #1 (COBFIK) '

@ CCDC Mogul 2021.2.0: COBFIK (P1) - Mercury - | x

Summary:

File Searches Databases Help

Build query Results and analysis View structures

° \/e ry U ﬂ U S U a | tO rSlO ﬂ a n g |eS Results Navigator Mogul search - Torsion angle - N1 C1 C6 N2

All hits: 2192 10107

\/\/|t h C/S con fO rrmat | on Accepted hits: 2192 value in query: 0.148°

R-factor: Any Heaviest Element: Any
Exclude: Organometallics, Powder structures

PY Relevance MNumber Contribution 808 |~ """"""""""""""""""""""""""""""""
Mogul shows a preference S E——— Q . O
for trans arrangement of S S
bipyridine nitrogens

Mumber of hits

* cis substantially less stable
t h a n Z’/’OHS for th |S mO|eC u |e View diagrams...| ‘ Mare hits... 202 e .................................................................. ..............................................

CIS
(energy calculations)* statistics e | |
Sele-l.n—ftzadl igi ’ ® Torsiongi(j]ngle-,ur o

¢ U n u S u a | bo n d | e n g t h S a n d | dlemin) | +10.000° Click to (de)select bars; click and drag to (de)select a range

valence angles for one of o oaa lbores
H . Histogram display Select all hits in histogram CSD5-42 Iil
the aromatic rings + ADPs s

‘ Displayed hits: 2192 CSD Feb21 update | | ‘ Filters... Cluster
All fragments... ‘ ‘ View query... CSD May21 update | m

|OO k | I EE ES LJ (: L J 63 . Deselect | all hits in histogram

St ra g : t r t r Selected hits: 2192 CSD Sep21 update I:I

solution possibly incorrect?

Histogram: click in bar to deselect, click again to reselect. Right-click for options.

*CrystEngComm, 2020, 22, 7217-7228. DOI:10.1039/c9¢ce02001b C C D C
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Example #2 (BOLLUK) \

»
- < .
« BOLLUK (5-fluorouracil benzonitrile) 8 N7 NS
-
. . ! e B
« 2 torsion angles returned as slightly unusual . A XA
3
a >
@ Mogul Results Viewer — O * &,
o
Showe / hide : ‘ Columns v‘ | Fragments... ‘ [ ‘Deselectallfragments| I
-
[ Double click to view result in Mogul
@
Type Molecule Fragment Classificat/i\on MNo. of hits Query value Mean 5td.dev. |z-score| |x-mean| Minimum Maximum Median |d{min)| Local density ®
v torsion
BOLLUK_1
v BOLLUK_2
C6 C5C11 N3 Unusual (enough hits) 187 -61.594 0.694 0.043
C10 C5C11 N3 Unusual (enough hits) 187 117.104 0.724 0.043

Mogul settings: No powder structures C C D C



Example #2 (BOLLUK) Wi

0 CCDC Mogul 2021.2.0; BOLLUK (P21\c) - Mercury

« Spread of torsion
values across the
whole degree
range, but....

File Searches Databases Help

16 -

12 -

Build query Results and analysis View structures
Results Navigator
Al hits: 187 20
Accepted hits: 187
R-factor: Any  Heaviest Element: Any
Exclude: Powder structures
Relevance MNumber Contribution
> 1.00 187 100.0%
A
£
LT
(=]
i
0
E 8
2
View diagrams...‘ | More hits... 4
Statistics
0
Total : 187
Selected : 187
| d(min) | : 0.6942

All fragments... || View query...

Mogul search - Torsion angle - €6 C5 C11 N3

Value in query: 61.594¢

] 45 a0 135 180
Torsion angle [ @

Click to (de)select bars; click and drag to (de)select a range

Data libraries

Hist: displa
egram display all hits in histogram CSD 5.42 lil

Displayed hits: 187 CSD Feb2l update | | ‘ Filters... Cluster

Selected hits: 187

| CSD May21 updat |
all hits in histogram ayes update I—I
CSD Sep21 update | 0|

Histogram: click in bar to deselect, click again to reselect. Right-click for options.




Example #2 (BOLLUK) ]

« Molecule with ‘'unusual torsion angles AR
has a cyano group C=N (carbon to 3 ‘ -
nitrogen triple bond)

 C-C=N angle is typically quasi-linear

(180°)
+ Adjacent C-C bond is not counted as a O CO— CM=N3
typical rotatable bond

£2CCN =179.35°

« ‘Not unusual/unusual’ definition is not
as meaningful for nitriles (cyano-
containing compound)

« Looking at the hits shows very little summary:
difference in conformation around the
aromatic nitriles

* |gnore nitrile (cyano group) results

D



Example #3 (RENJUR) ]

- RENJUR (Spirobacillene A) 8 ANLT N A

* 1rotatable bond between two five-membered rings v AL
o
. 4 >
« Tof 4 torsion angles returned as unusual
5 b g
@ Mogul Results Viewer - O * I -
Show / hide : Fragments... Deselect all fragments Export... ! ®
| o
Help I Double click to view result in Mogul ‘
s |
Type Molecule Fragment Classification No. of hits  Query value Mean 5td.dev. |z-score| |x-mean| Minimum Maximum Median |d{min)| Local density
v torsion
v RENJUR !
C11C13 C8 C7 Mot unusual (encugh hits) 70 -146.184 0.000 0.386 i
C11C13C8CT Mot unusual (enough hits) 36 40.278 0.000 0.278 |
C14 C13 C8 C7 Not unusual (enough hits) 81 36.684 0.000 0.333 |

C1C8 C13 C14 Unusual (enough hits) 193 -136.854 0.000 0.016




=

Example :

* Observed value
appears unusual,
lying in extreme
tail of distribution

e Structures with
lower relevance
are included with

default settings
(find = 40 hits)

1

e
- & .
_
»
®,
a g
o CCDC Mogul 2021.2.0: RENJUR (P21\n) - Mercury - O

File Searches

Databases Help

Build query Results and analysis
Results Navigator

All hits: 193

Accepted hits: 193

R-factor: Any Heaviest Element: Any
Exclude: Organometallics, Powder structures

Relevance MNumber Contribution
> 1.00 3 1.6%
> 0.85 1 0.5%
> 0.78 189 97.9%

View structures

View diagrams... ‘ ‘ More hits...

Statistics

Total : 193
Selected : 193
| d(min) | : 0.000°

All fragments... H View query...

mMUmber of hits

50

40

30

20

10

Histogram display

Displayed hits: 193

Selected hits:

Mogul search - Torsion angle - C1 C8 C13 C14

0 45

an
Torsion angle [ 2

Click to (de)select bars; click and drag to (de)select a range

Deselect
193

Histogram: click in bar to deselect, click again to reselect. Right-click for options.

all hits in histogram

all hits in histogram

Data libraries

CSD 5.42

(-]

135

i |Value in query: 136.854°

CSD Feb21 update

Filters...

CSD May21 update | N
CSD Sep21 update | |

Cluster




Example :

Exploring lower
relevance structures

Majority are
fluorinated around
5-membered ring

Few more are
constrained as part
of macrocycle

Fluorinated
compounds known
to show different
conformational
preferences to
non-fluorinated
compounds

+3 (RENJUR)

@ ccDC Mogul 2021.2.0: RENJUR (P214n) - Mercury

o View Diagrams

*

Entry: FIRCEA

File Searches Databases Help Torsion angle: 32.64°
Build query Results and analysis View structures
Results Navigator Mogul search
All hits: 193
Accepted hits: 189
R-factor: Any Heaviest Element: Any
Exclude: Organometallics, Powder structures
Relevance Number Contribution
> []1.00 3 1.6%
> [ 1085 1 0.5%
5 0.78 189 97.9% Fragment
£ Substructure
£
R
(=]
N R S | Showing 189 hits with relevance 0.78 in increasing value of angle
Z
I << _>>
I‘View diagrams... More hits... T s
Statistics . _
Total - 189 0 45 a0 135 180
Selected : 180 Torsion angle / ©
| d(min) | : 10.696° | N O O R B |
Click to (de)select bars; click and drag to (de)select a range
Data libraries
Histogram displa
o9 Py all hits in histogram C5D 5.42 El
Displayed hits: 189 CSD Feb21 update | | ‘ Filters... Cluster

All fragments... H View query...

Deselect | all hits in histogram

Selected hits: 189

Histogram: click in bar to deselect, click again to reselect. Right-click for options.

CSD May21 update | N
CSD Sep21 update | = |




Example #

« Only considering
high relevance
excludes fluorinated
structures

 Hits localised around
observed torsion value

Summary:

« Torsion angle in
RENJUR not unusual
given context
(though only low
number of structures
to compare with)

3 (RENJUR)

e >Searcnes Databases Help

@ ccDC Mogul 2021.2.0: RENJUR (P21\n) - Mercury

All fragments... View query...

Mogul search - Torsion angle - C1 C8 C13 C14

i |value in query: 136.854¢

a0
Torsion angle [ ©

Histogram display

Select

Displayed hits: 4

Deselect

Selected hits: 4

Histogram: click in bar to deselect, click again to reselect. Right-click for options.

all hits in histogram

Build query Results and analysis View structures
Results Navigator
All hits: 193 10
Accepted hits: 4
R-factor: Any  Heaviest Element: Any
Exclude: Organometallics, Powder structures
Relevance MNumber Contribution 8 -
> 1.00 3 1.6%
> 0.85 1 0.5%
> [ ]o7s 189 97.9% 6
2
i
[T
(=]
]
0
E 4
2
View diagrams... Mare hits... 2
Statistics 0
Total : 4 o 45
Selected : 4
| d(min) | : 0.000° |
Click to (de)select bars; click and drag to (de)select a range

Data libraries

all hits in histogram CSD 5.42 |

CSD Feb21 update

CSD Sep21 update

CSD May21 update | I

Filters... Cluster




Example #4 (ADELUR) .

- ADELUR ((E)-2,4-Dichlorobenzaldehyde oxime) e AN

* No unusual torsion angles . A
@ Mogul Results Viewer - O X &v,
Show [ hide : ‘ Columns - | ‘ Fragments... ‘ [ ‘Deselect all fragment5| I

I Double click to view result in Mogul
@

Type Molecule Fragment Classificatioﬁ MNo. of hits  Query value Mean Std dev. |z-score| |x-mean| Minimum Maximum Median |d{min)| Local density
v torsion
v ADELUR
C6 C7 N1 01 Mot unusual {enough hits) 330 179.286 0.000 0.967
C1C6 C7 N1 | Not unusual {enough hits) 170 162.701 0.000 0.529
C5 C6 C7 N1 | Not unusual {enough hits) 250 -18.062 0.000 0.116

2 torsion angle definitions for same rotatable bond

Both returned as ‘not unusual’, but....

D



Mumber of hits

60

48 -

36

29

12

Example #4 (ADELUR)

9 Mogul Results Viewer

« Torsion angle from N to C Stow e | Caumns | [ Fragmens..| | [pesdectolifagmens| | | epor.

with Cl substituent (N1 to C1) | vep || Doubleciktoview resut i Hogul

. . ~ torsion
* Single population < roer
. . . C6 C7 N1 01 Not unusual (enough hits) 330
d |St Il b U t 1ON C1C6C7T N1 Not unusual (enough hits) 170

C5C6C7 N1 Mot unusual (enough hits) 250

Mogul search - Torsion angle - C1 C6 C7 N1

Value in query: 162.701°|

0 45 a0 135 180

Torsion angle [ @

Type Molecule Fragment Classification MNo. of hits  Query value Mean 5Std. dev.

| z-score | |x-mean| Minimum Maximum Median |d{min)| Local density

« All hits for this torsion have C|
substituent on the carbon atom

Always trans arrangement
between this C and the N,
never cis

D




Mumber of hits

130

104

78

32

26

Example #4 (ADELUR)

0 Mogul Results Viewer

* Torsion angle from N to

Show [ hide @ |Go|umn5 | |Fragment5...| [ |De5e\ecta|\fragments| [ | Export...

the Other C (N-l to CS) [Douhledd:toviewrmuninnnogul

Type Molecule Fragment Classiﬁca‘[ioﬁ MNo. of hits  Query value Mean Std.dev. |z-score| |x-mean| Minimum Maximum Median |d(min)| Local density
M M v torsion
* Major and minor < apeLR
N . . . . C6 C7 N1 01 Not unusual (enough hits) 330 179.286 0.000 0.967
po p U | ations 1IN d ISTri b dtion €1C6C7NT Not unusual (enough hits) 170 162.701 0000  0.529
C5C6 C7 N1 Not unusual (enough hits) 250 -18.062 0.000 0.116

Mogul search - Torsion angle - C5 C6 C7 N1

Value in query: 18.062°

0 45 90 135 180

Torsion angle [ ©

* Observed torsion in Minority
population (cis) — higher energy?
Trans more usual (major population)

« Always check the distributions, even
when reported ‘Not unusual’

D



Mumber of hits

Mumber of hits

60

Mogul search - Torsion angle - C1 C6 C7 N1

48 -

36

24 -

12 |

Value in query: 162.7019]

45 a0 135 180
Torsion angle [ @

Magul search - Torsion angle - C5 Cg C7 N1

130

104 |

Value in query: 18.062°

a0
Torsion angle [ @

Example #4 (ADELUR) @

o Maogul Results Viewer

.

Show [ hide : ‘ Columns v‘ |Fragrnent5...‘ [ |Deselectallfragrnent5| I | Expc

I Double click to view result in Mogul o

Type Molecule Fragment Classificatioﬁ No. of hits  Query value .
v torsion =
TT——_ || v ADER
\\ €6 C7 N1 01 Notunusual (enough hits) 330 179.286 .
C1 C6 CT N1 Mot unusual {(enough hits) 170 162.701
C5C6 C7T N1 Mot unusual (enough hits) 250 -18.062
/ .,
/

* Histograms for complementary
torsions of same rotatable bond
suggest that both prefer a trans
arrangement — not possible

* Only one possibility for N1 to C1 torsion,
two possibilities for NTto C5 torsion...

D

&



Mumber of hits

130

104

78

52

26

Example #4 (ADELUR)

Mogul search - Torsion angle - C5 C6 C7 N1

Torsion angle / @

Value in query: 18.0:62° ]
trans
Cis
== =B
45 a0 135 180

These structures don't often
have an OH group hence
geometry less constrained

Exploring contributing structures

Mogul “requires”
non-H substitution at
this point adjacent to
the target torsion but
does not have to be
chlorine

Lots of these structures have
OH group and intramolecular
H-bond “forcing” trans




Example #4 (ADELUR) "

3 ° . R
Summary: N . z
Mogul search - Torsion angle - C5 C6 C7 N1
« One torsion angle in 130 Value in query: 18.062°
mMinor population, ; 5 5
reflecting cis geometry of T S B __________________________________________________________________ __________________________________________________________
N and non-substituted C | : '
- Intramolecular H-bond 2" \ P —or
winoHonswsteac 3 || X Oy
‘forces” trans geometry ;7 | :
(major population) oS I R R S R e
« Torsion angle in minor “s '
population not unusual, ) .—h . . .
especially when context U ® Torson ange/ . *

examined

D



Exploring Mogul results

If unusual torsion angle(s), investigate how unusual , } S ;

« Are there extra thingsto learn?
* Areless relevant structures included in the hits? Sas i
« Could the torsion be “usual” given context?

Mogul search - Torsion angle - N1 C1 C6 N2

10107 ygie in query: 0,148°

Consider multiple torsion angles for same rotatable bond

808

« Are they all unusual? If not, investigate further

g
]
E 404

Check all torsion angles, not just those returned as unusual

202

« Observation in minority population — could be a risk (higher energy?)

o 45 90 135 180
orsio

Bond lengths and valence angles more relevant for highlighting
poor structure refinement, difficulties with accurately locating
disordered atom positions, or some strain in the structure
(usually in conjunction with unusual torsion angles)

CCDC



Explore More: More advanced uses

* Not enough time to explore all the insights that you can
get from Mogul.

* But here are a selection of examples from published
scientific articles.

The session has resumed recording < < l N



Prevalence of unusual torsions

« Occurrence of unusual torsions in the CSD investigated with Pythaon API.  *

« Organic molecules

- Best R-factor subset (no redeterminations)

« 3D coordinates, no disorder, no errors, Nno polymers

 Around 3% of the total torsions are unusual

« Around 15% of organic crystal structures have at least one "unusual” torsion

Solid form type Torsions Unusual torsions (%) Crystal structures Structures with unusual torsions (%)
Single component 948 839 3% 172524 15%
Solvates 72038 3% 9837 17%
Hydrates 45 858 3% 7232 15%
Cocrystals 32928 3% 6191 12%
Salts 76944 4% 15559 14%

CrystEngComm, 2020, 22, 7217-7228. DOI: 10.1039/c9ce02001b

CCDC




Relative Energy (kcal/mol)

Energy distributions

« DFT energy scan across torsion angle
range for protein complex inhibitors

g L 1 ! I I I I I I
[ N —
8 [ /D_@ L/
PhO,8" % Phogs” M :
r V—e— VI —r—
7 b ]
N N
Lo~ Lo~
6 L Pnoss” S PhO;s” N ]
r VI —e— X ——
5 L 5 N= ]
[ 2 =
! Y
PhQ,& PhO ;S
. .

100
Dihedral Angle (Degrees)

80 120 140

J. Med. Chem., 2015, 58, 4462-4482. DOI10.1021/jm5018175

Mamber of hits

210

168

126

42

» - « 0
« Correlation with Mogul histogram |
distribution for fragment search '
(for black/orange molecules) &
* Mogul > Build Query > Draw > Search \

- No organometallics / powder structures

135

D

a0
Torsion angle / @

0 45

180



Conformational adjustment 7S
& conformational change |

« Relationship between
different conformers
based on (gas-phase) ~
energy minima for
torsion angle with

Conformational

rotation around bond Adjustment
* Unusual conformational
adjustment more Conformational
common than unusual E -I el
conformational change
Torsion Angle Conformational
Change

CrystEngComm, 2020, 22, 7217-7228. DOI: 10.1039/c9ce02001b ( :( : I )( :



Protein-ligand complex anaIyS|s to identify .
unusual torsional geometry in drug candldates

Liebeschuetz, J. J. Med. Chem.,
Identify the prevalence of 2021, 64, 11, 7533-7543 SR
doi.org/10.1021/acs.jmedchem.1c00228

from the
| PDB using a biomolecular modelling
¥ interface, including

to act as “best-possible
f resolution” of non-liganded @
( structures.

) -

Group by : - Rare with a perfect fit
Perfect, Imperfect and MU'“P'E-‘ - No more prevalent than in CSD's

Occupancy drug-like entries with a good fit
v
l \J % A

(, by fit group with
. - Similarities between ligand and non-

- Observed in 21% of the multiple

liganded structures occupa nciset ¢ sinal
- Occurrences of unusual torsional geometry - May contribute to %5% © 5'"9 €
) occupancy cases with poor fit

\.

Read the blog G
https//www.ccdc.cam.ac.uk/Community/blog/Protein-ligand-complex-analysis-to-identify-unusual- ( < | ><

torsional-geometry-in-drug-candidates/




